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CHAPTER 1

Introduction

This guide covers intermediate and advanced usage of the Galaxy-P platform for proteomic and mass spec data anal-
ysis. For an gentle introduction to Galaxy, please check out the Galaxy 101 maintained at Penn State.



https://main.g2.bx.psu.edu/u/aun1/p/galaxy101
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CHAPTER 2

Galaxy-P 101 - Building Up and Using a Proteomics Workflow

This section is heavily inspired by the Galaxy 101 maintained at Penn State by the core Galaxy team
<http://wiki.galaxyproject.org/GalaxyTeam>.

In this walkthrough we will introduce you to basics of Galaxy-P:
* Uploading database using Protein Database Downloader.
 Getting raw data from an external source.

* Peaklist processing including options and parameters.

* X! tandem search.

* PeptideProphet processing of X!tandem search.

* Converting PepXML to a table.

» Using ProteinProphet to process PeptideProphet results.
* FDR analysis.

¢ Performing simple data manipulation.

* Understanding Galaxy’s history system.

* Creating and editing workflows.

* Applying workflows to your data.

2.1 What Are We Trying to Do?

We are trying to set up a search of one RAW file (your experimental data acquired on an LTQ/Orbitrap instrument)
against a database using a search algorithm named X!tandem. The idea is to estimate number of valid matches by
using PeptideProphet or ProteinProphet and FDR analysis. Once we have created this workflow we can apply this
workflow to another dataset and get results. So let’s try it...

2.2 Setting Up Your Galaxy-P Account

Go to the User menu at the top of Galaxy-P interface and choose Register:

Follow the instructions as prompted.



https://main.g2.bx.psu.edu/u/aun1/p/galaxy101
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2.3 Organizing Your Windows

To get the most of this tutorial open two browser windows. One you already have (it is this page). To open the
other, right click and choose “Open in a New Window” (or something similar depending on your operating system and
browser):

Open Link in New Window

Open Link in New Tab

Download Linked File
Download Linked File As...
Add Link to Bookmarks...

Copy Link

Then organize your windows as something like this (depending on the size of your monitor you may or may not be
able to organize things this way):

Private Page | Galaxy-P 101

Galaxy-P 101: Building up and using a proteomics workflow

o basics of Galaxy-P:

WWFSMD?
grow noodly appendages.

n an LTQ/Orbitrap instrument) against a database using 3
by using Peptideprophat or ProteinProphat and FOR analysis.
= S lats ty it

Organizing your disp
Nowthat you are in Galaxy-P e assume you have 2 valid login and passvord and have also gone through tutorial on accassing Galaxy-P.

0.0. Getting your display sorted out
wtori

To gat the
= e win

vser vindovs. One you alresdy have (i is this page). To open the other, right dlick and choosa "Open in
epanding on your cparating systam and brovesr)

Open Link in New Window
Open Link in New Tab

Download Linked File
Download Linked File As.
Add Link to Bookmarks...

Copy Link

2.4 Loading a Search Database

There are a many options for how you can upload your search database (FASTA file with protein sequences). Three

among these are:

¢ Protein Database Downloader.

Getpats

PROTEOMICS: COMMUNITY
Openms

Protk

utilities

FASTA Manipulation

BIOINFORMATICS
nee1BLAST:
EmBoSS

¢ Use website link for the database (see this short tutorial).

* Upload database from the data library.

usegalaxy.org

This project is supported in part by NSE, IHGRI, and the Huck Institutes of the Life Sciences

In this tutorial, we will explore using Protein Database Downloader for database search.
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2.5 Using Protein Database Downloader

Now we get our search database. First thing we will do is to go to Tools —> Proteomics: Galaxy-P —> Get Data. Then
click on Protein Database Downloader.

Get Data

= PRIDE BioMart Download proteomic
data from the EBI Pride BioMart.

= Protein Database Downloader

Since we are going to analyze a human dataset, select human database along with isoforms.

Protein Database Downloader (version 0.1.0)

Download from:

UniProtke =
Taxonomy:
Homo sapiens {Human) j

Include isoform data:

I

Clicking on “Execute” will download the human canonical isoform database.

After this you will see your first History Item in Galaxy’s right pane. It will go through gray (preparing) and yellow
(running) states to become green:

History o
wE .
Unnamed history 0 bytes

& 1: Protein Database ® { &

For contaminants database, we will use the Protein database Downloader, select cRAP (contaminants) database and
“Execute” much the same way you did for the human UniProt database.

Protein Database Downloader (version 0.1.0)

Download from:

cRAP (contaminants) ;I

Output
A FASTA file containing the specified protein sequences.

After this you will see your second History Item in Galaxy’s right pane.

2.5. Using Protein Database Downloader 5
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Unnamed history 67.1 MB

2: Protein Database @ 8

1: Protein Database & {1

2.6 Using the Database Merge Tool

In order to merge these two FASTA files in your history, go to Tools —> FASTA Manipulation —> Merge FASTA
Databases.

FASTA Manipulation:

" Create decoy databases
Creates a random protein

database with similar
properties to a real
protein database

Click on “Add new Input FASTA File(s)” — twice — so that your set up for merging files looks like this:

Merge FASTA Databases (version 0.1)

Input FASTA File(s)s
Input FASTA File(s) 1
FASTA File:

I 1: Protein Database ;I

l Remowve Input FASTA File{s) 1 J

Input FASTA File(s) 2

FASTA Fila:
I 2: Protein Datahase;l

l Remowve Input FASTA File(s) 2 ]

| Add new Input FASTA File(s) |

Click on Execute and you will be able to see your third History Item in Galaxy’s right pane.

History o
v A
Unnamed history 67.1 MB

& 3: Merged FASTA ® B
from data 1 and data 2

2: Protein Database @& i

1: Protein Database @ 7

6 Chapter 2. Galaxy-P 101 - Building Up and Using a Proteomics Workflow
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2.7 Creating a Decoy Database

Our next step is to create a decoy database out of the merged file (3rd history item on the list).

For this, go to Tools -> FASTA Manipulation —> ‘Create Decoy Database’.

= Create Decoy Database (reverse)

Creates a decoy search database
by adding reverse sequences to
an existing database.

Ensure that history item 3 shows up in the “FASTA Input:” box and that the box for “Include original entries in output
database:” is checked. Change Decoy prefix to REV_.

Your parameters for creating decoy database (reverse) tool should look like this.

Create Decoy Database (reverse) (version 0.1.0)

FASTA Input:
I 2: Merged FASTA from.. and data l;l

W

Specify advanced decoy frequency options?:

I No, just create database with one reversed sequence for every input sequence ;I

Decoy Prefix:

Click on “Execute” to generate the fourth item in your history list. This is the FASTA database that we will be using
for our search.

@ 4: Create Decoy @ {32
Database (reverse) on data 2

3: Merged FASTA from @& (/ 32
data 2 and data 1

2: ftp: [ [ftp.thegpm.org @& § 5
[fasta/cRAP/crap.fasta

@ {f K

1:
http:/ /www.uniprot.or

funiprot
[?guery—organism%3a0606+k

eyword¥o2alldS&force=yesk
format=fastaBinclude=vyes

Now we will rename the history items to “Human UniProt”, “cRAP”, “Merged Human UniProt cRAP” and “Tar-
get_Decoy_Human_Contaminants” by clicking on the Pencil icon adjacent to each item. Also we will rename history
to “Galaxy-P 101” (or whatever you want) by clicking on “Unnamed history” so everything looks like this:

2.7. Creating a Decoy Database 7
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OB A=
Galaxy-P 101 158.4 MB
4: ® 7 H

T_amet Decoy Human Contami
nants) on data 3

3: Merged Human @ (2
UniProt cRAP

2: cRAP & ¢ %
1: Human UniProt @& ¢ B

Please feel free to explore tabs — Convert Format, Datatype, Permissions while you are editing the attributes. This is
especially important while troubleshooting for steps that fail wherein a datatype has not been set properly or needs to
be changed for subsequent steps.

‘ Attributes ‘ Convert Format Datatype Permissions

Edit Attributes

Name:

‘Target_Decoy_Human_Contaminants

Info:

Annotation / Notes:

MNone

Add an annotation or notes to a dataset; annotations are available when a history is viewed.

Database/Build:

‘Click to Search or Select

Save |
Auto-detect |

This will inspect the dataset and attempt to correct the above column values if they are not accurate.

The next step is to upload RAW file.

There are a few options on how you can upload yours spectral data (RAW file acquired on a LTQ/Orbitrap) * Upload
from your computer using your web browser. * Upload from your computer using the Galaxy-P FTP server. * Use
website link for the RAW file (something we will use for this tutorial). * Import data from the data library.

While there are many ways of uploading a RAW file, we will use a weblink to upload a fractionated human salivary
RAW file.

In order to upload a RAW file, you can go to “Upload File” in Tools section and type in
https://netfiles.umn.edu/users/pjagtap/Galaxy-P 101/Raw101.RAW and “Execute”.

8 Chapter 2. Galaxy-P 101 - Building Up and Using a Proteomics Workflow
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Upload File (version 1.1.3)

File Format:

|Autu-dete-|:t

Which format? See help below

File:

| _Browse. |

TIP: Due to browser limitations, uploading files larger than 2GE is guaranteed to fail. To upload large fils

URL f Text:

https://netfiles.umn.edu/users/pjagtap
/Galaxy-P 101/Rawl0l.RAW

Here you may specify a list of URLs (one per line) or paste the contents of a file.
Files uploaded via FTP:
File Size
Your FTP upload directery contains no files.
This Galaxy server allows you to upload files via FTP. To upload some files, log in to the FTP server at lo

Convert spaces to tabs:

I_ as

Use this option if you are entering intervals by hand.

Genome:

|C|ic|-c to Search or Select

This will give us our 5th history item :

Galaxy-P 101 158.4 MBE
@ s: ® § %
https: / fnetfiles.umn.edu /usars

{piagtap/Galaxy-P
101 /Rawlod.RAW

4 ® %
Target Decoy Human Contami
nants) on data 3

2: Merged Human & 0%
UniProt cRAP

2: cRAP ® {2
1: Human UniProt i {? ®

We can change the name of the RAW file to Raw101.RAW by using the pencil icon button.

2.7. Creating a Decoy Database 9
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Attributes

Convert Format Datatype Permissions
Edit Attributes
Name:

Rawlll.RAW

Info:

https://netfiles.umn.edu/users
/pjagtap/Galaxy-P
i01i/Rawlli.RAW

Annotation / Notes:

None

Add an annotation or notes to a dataset; annotations are available when a history is viewsd.

Database/Build:
| Click to Search or Select

Save I

Auto-detect I
This will inspect the dataset and attempt to correct the above column values if they are not accurate.

2.8 Peaklist Processing

In the next step we will process the Raw file into a peaklist in mzml format so that it can be searched using X!tandem.

For this go to Tools —> Proteomics: Galaxy-P —> Peak List Processing —> msconvert3 raw

PROTEOMICS: GALAXY-P
Paak List Processing
* mgconvertd Convert and

filter 8 mass spec peak list

mgconverty raw Convert an

filter @ Thermao Finnigan
RAW file

® Subset Peak List against list

of scan numbers or indices.

s MGF Formatter convert peak
lists inta MGF files formatted
for particular downstream
applications.

» msZpreproc preprocess and
filter MS/MS spectra

Explore the features by clicking on Use Filtering. However, for this tutorial we are going to use default settings for
msconvert.

Click on “Execute” by ensuing that the settings appear as shown below:

10 Chapter 2. Galaxy-P 101 - Building Up and Using a Proteomics Workflow
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msconvert3 raw (version 0.1.0)

Thermo Finnigan RAW Input:
| 5: Rawi01.RAW ¢

Output Type:
| mzML (indexed) ;I

Use Filtering?:
r

Advanced Settings:
I Use Defaults ;l

We have our sixth history item in the history list now.

History kg
LS 7
Galaxy-P 101 267.5 MB

& 6: msconvert3 raw @& § 2

on data 5
5: Rawl01.RAW & [ i
41 @ i

'ITamet Decoy Human Contami
nants) on data 3

3: Merged Human ® {3
UniProt cRAP

2: cRAP ® {8
1: Human UniProt @® {3

Change the name of the mzml file to “Peaklist Raw101”. Note that this peaklist is in mzml format.

2.8. Peaklist Processing 11
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Attributes Convert Format Datatype Permissions
Edit Attributes
Name:

Peaklist Rawl0l |

Info:

msconvert --mzML -o -
output input.RAW -c filters -

fixme:heapiHeapSetlnforma

Annotation / Notes:

None

Add an annotation or notes to a dataset; annotations are available when a history is viewed.

Database/Build:
|C|i1:|-c: to Search or Select

Save I

Autu—detectl
Thiz will inspect the dataset and attempt to correct the above column values if they are not accurate.

2.9 X! Tandem Search

For setting up a search of peaklist (Peaklist Raw101) against FASTA database (Target_Decoy_Human_Contaminants)

using X!tandem, go to Tools—> ProtK (under PROTEOMICS: COMMUNITY) —> X!Tandem MSMS Search.
Protk

= |nterProphet Combine Peptide
Prophet results from multiple
search engines

s OMSSA MSMS Search Run an
OMSS5SA MS/MS Search

= Peptide Prophet Calculate Peptide
Prophet statistics on search results

= Protein Prophet Calculate Protein
Prophet statistics on search results

s XlTandem MSMS Search Eun an
XTandem Search

Set up search parameters for X!tandem as shown below. Ensure that you have the right FASTA file (4: Tar-

12 Chapter 2. Galaxy-P 101 - Building Up and Using a Proteomics Workflow
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get_Decoy_Human_Contaminants), MSMS File (6: Peaklist Raw101) and click on Oxidation M for variable mod-
ifications. Ensure that you have 2 Missed Cleavages allowed, Trypsin as an enzyme, Fragment ion tolerance at 0.5 Da
and Precursor ion tolerance at 10.0 ppm. The parameters file should look like below:

2.9. X! Tandem Search 13



Using Galaxy-P Documentation, Release 0.1

¥1Tandem MSMS Search (version 1.0.0)

Database source:

I Your Upload File;l

Uploaded FASTA fila:
|4: Target_Decoy_Huma..s on data 3 ;I

MSMS File:

I &: Peaklist Raw101l = |
An mzML file with M5/MS data

Variable Modifications:

Carbamidomethyl C ;I
Glycocapture-N

Hold the appropriate key while clicking to select multiple items

Custom Variable Modifications
You can specify a modification when present in a motif. For instance, 0.998@MN{P}[5T] is & deamid:z

[ Add new Custom Variable Maodifications J

Fixed Modifications:

Carbamidomethyl C :I
Glycocapture-N
[

Oxidation M
Hold the appropriate key while clicking to select multiple items

Custom Fixed Modifications
You can specify a modification when present in a motif. For instance, 0.9983@N{P}[ST] is a deamidz

[ Add new Custom Fixed Modifications ]

Missed Cleavages Allowed:

BEl

Allow peptides to contain up to this many missed enzyme cleavage sites

Fragment ion tolerance:

Fragment Ion Tolerance in Daltons

Precursor ion tolerance:

10.0

Precursor Ion Tolerance (Da or ppm)

Precursor Ion Tolerance Units:
PRM LI

Enable semi-cleavage rules:

v

Match peptides where one end or the other does not conform to specified enzyme rule.

T

Allow multi-isotope search:

—

This allows peptide candidates in windows arcund -1 Da and -2 Da from the acquired mass to be cor
iz not corrected to the monoisctopic mass.

Use K-Score Alogirthm:
v
14/ "= feoscers loainthm = = ERaptery. Galldky P 1017 Building Up 4hd Using 3 Protéomics Workflow

Thresholds:
I ISB k-Score defaults ;I

Set various X! Tandem threshold values.
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Your history list should look like this now.

History o
v

Galaxy-P 101 419.9 MB
7: @ "

XiTandem ws Target Decoy H
uman Contaminants.Peaklist
Rawl0l.Peaklist

Rawl0l.pepXML

6: Peaklist Raw101 ® 1
| 3: Rawl0l.RAW ® (5
. ar @® "

W
. 2: Merged Human L -

UniProt cRAP

2: cRAP ® {x

1: Human UniProt ® R

2.10 Peptide Prophet Processing of X! Tandem Search

In this step we will process PepXML results from X! Tandem search to provide peptide probability scores for further
analysis.

For this, go to Tools—> ProtK (under PROTEOMICS: COMMUNITY) —> ‘Peptide Prophet’.
Protk

The Peptide Prophet parameters should be specified as follows:

InterProphet Combine Peptide
Prophet results from multiple

search engines

OMSSA MSMS Search Run an

OMSSA MS/MS Search

Peptide Prophet Calculate Peptide
Prophet statistics on search results

Protein Prophet Calculate Protein
Prophet statistics on search results

XTandem MSMS Search Run an

X!Tandem Search

2.10. Peptide Prophet Processing of X! Tandem Search 15
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Peptide Prophet (version 1.1.0)

Raw Search Results:

7: X!tandem vs Targe..wlﬂl.perMLj

These files will typically be outputs from omssa or xtandem search tools

Expect true positives to have a glycocapture motif:

-

Use icat information:

-

Use phospho information:

-

Use pI information:
Use hydrophobicity / RT information:

Use accurate mass binning:

-

Don't use NTT model:

-

Don't use NMC model:

I_

Use Gamma distribution to model the negatives:

-

Applies only to X!Tandem results

Only use Expect Score as the discriminant:

Applies only to X!Tandem results. Helpful for data with homologous top hits e.g. phospho or glyco

Force fitting:
-

Bypasses automatic mixture model checks and forces fitting of a mixture model

Allow multiple instrument types:
-

Warning instead of exit with error if instrument types between runs is different

Maldi data:
-

Decoy Prefix:

Identifier prefix of decoy entries in search database.

Manually specify database:

This may be needed for pepXML files generated outside of Galaxy or Protk, in most cases you will not need to set this.

Change the name of the Peptide Prophet file to “peptide_prophet Raw101.pep.xml” by using the pencil icon.

16 Chapter 2. Galaxy-P 101 - Building Up and Using a Proteomics Workflow
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History b
OB A=
Galaxy-P 101 420.9 MB

8: peptide _prophet @® [ i
Rawl0l.pep.xml

7: & {5
X'Tandem ws Target Decoy H
uman Contaminants. Peaklist
Rawilll.Peaklist

Rawldl.pepXML

6: Peaklist Rawi101 & [ i
3: Rawl01.RAW @ {1
4: @® [ 5
Target Decoy Human Contami
nants

3: Merged Human @ [ it

UniProt cRAP

2: cRAP @ [ &

1: Human UniProt & 5

In this step, we will use ProteinProphet to process PeptideProphet results from X!tandem search to provide protein
probability scores for further analysis.

For this, go to Tools — ProtK (under PROTEOMICS: COMMUNITY)—> Protein Prophet.

2.10. Peptide Prophet Processing of X! Tandem Search 17
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Protein Prophet (version 1.0.0)

Peptide Prophet Results:

I 8: peptide_prophet Rawlll.pep.xml ;I
These files will typically be outputs from peptide prophet or interprophet

Inputs are from iProphet:

-

Don't apply Occam's razor:

When selected no attempt will be made to derive the simplest protein list explaining observed peptides

Use group weights:

=

Check peptide's total weight (rather than actual weight) in the Protein Group against the threshold

Mormalize NSP using Protein Length:

-

Use the log of probability in the confidence calculations:

=

Use the EM to compute probability given the confidenct:

=

Consider all possible peptides in the database in the confidence model:

Report results for unmapped proteins:

-

Use Expected Humber of Ion Instances to adjust the peptide probabilities prior to NSP adjustment:

=

Do NOT use peptide degeneracy information when assessing proteins:

-

Minimum peptide prophet probability for peptides to be considered:

Minimum percentage of independent peptides required for a protein:

]

This will generate 9th history item in the list.

2.11 Converting ProtXML to a Table

In this step we will convert Protein Prophet results to a tabular format so that they can be viewed or processed for
further analysis.

For this, go to Tools —> Utilities (under PROTEOMICS: COMMUNITY) —> Convert ProtXML to Tabular. Ensure
that the latest file in the history (protXML file — 9th in the list).

18 Chapter 2. Galaxy-P 101 - Building Up and Using a Proteomics Workflow
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Convert ProtXML to Tabular (version 0.1.0)

Prot XML Input:

I 9: protein_prophet.p..xml.protXML j

Clicking on Execute will give us our 10th file in our history.

Galaxy-P 101 1.0 GB

10: Convert ProtXML to @& § 3
Tabular on data 9

9: ® %

protein prophet.peptide proph
et Rawil0i.pep.eml.protXML

prot XML Search Results

format: protxml. database: 7
Tk

31
1

Explore the icons in the generate the file to see (‘eye’) the data OR to download (‘floppy disk’), view details (‘i”” sign)
OR rerun the analysis with changed parameters (blue ‘rerun’ icon). You can also create graphs and visualize using the
‘graph’ icon.

To change name,

W‘%ﬂ attributes. datatype
in main window, of the file.

panel, To delete the file.

10; Convert ProtXMLto @& (/ &
XLS on data 9

To download the 388 lines, 245 comments
file. format: protxml.csv. database:
K?
(SLOL9 ]

To view
details i Entry ¥usbar 2.Group Probablility 3 To create
sntey no. g=owp probability g_agh :él.tld
. visualize,
To rerun the paptidae sequance popt:
1 1.00008 ap|l¥SC HUMAN|.te|F@Y

Process.

at=fzatads. agitlaf-te| FAVVID | FEVVIZ_]

=/ tpp/ogi-bin/peptidansl hTmll.pl TPay

Al il

2.11. Converting ProtXML to a Table 19
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2.12 False Discovery Rate Analysis
In order to calculate FDR at the peptide level, we will first convert PeptideProphet file to a tabular format.
For this, go to Tools —> ProtK (under PROTEOMICS: COMMUNITY) —> Convert PepXML to Table. Ensure that the

peptide prophet file in the history (peptide prophet file — 8th in the list) is highlighted.

PepXML to Table (version 1.0.1)

Input File:

ﬂ |

| B: peptide_prophet Rawl0l.pepxml 2
A pepxNML file

Execute

Convert a pepXNL file to Tab delimited text

Change the name of this 11th file in history list to add “Table. ..” as shown in the image below.

| Attributes Convert Format Datatype Permissions
Edit Attributes
Name:

|Ta|:||e peptide_prophet Rawl0l.

Info:

Annotation f Notes:

Mone

Add an annotation or notes to a dataset; annotations are available when a history is viewed.

Database/Build:
|C|ic|-c to Search or Select

Number of comment lines:

]
_Save |

Auto-detect I
This will inspect the dataset and attempt to correct the above column values if they are not accurate.

20 Chapter 2. Galaxy-P 101 - Building Up and Using a Proteomics Workflow
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Next step is to sort the table with descending peptide probability scores. For this go to Tools —> Filter and Sort—> Sort.
Ensure that table (csv file — 11th in the list) is highlighted.

Also select c10 (10th column which has peptide probability values) for sorting in descending order.

Tools

" search tools G' _:J
GALAXY CORE

Get Data

Send Data

Text Manipulati

Filter and Sort

® Filtar data on any column

s Sort data in ascending or
descending order

W

expression

Join, Subtract and Group
Statisti

Graph/Display Data
Multiple regression

Sort (version 1.0.1)

Sort Query:

I 11i: Table peptide_pro..pep.xml.csv

on column:

I:m;|

with flavor:

| Mumerical sort - I

everything in:
I Descending nrder;l

Column selections

Add new Column selection

Click on ‘Execute’. This will create you 12th list in history.

To compute FDR on this file, go to Tools —> Statistical validation (under PROTEOMICS: GALAXY-P) —> Compute
False discovery Rate (FDR). Ensure that the sorted table (tsv file — 12th in the list) is highlighted. Also select cl
(1st column which has identifiers) for sorting in descending order. The parameters for this processing should look as

below:

2.12. False Discovery Rate Analysis

21
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(' ¥ galaxyp.msi.umn.edu/s

_ Galaxy
Tools . -

_I Compute False Discovery Rate (FDR) (version 0.1)
FASTA manipulati s
Input Table:

PROTEOMICS: GALAXY-P |12 p— F— _I

ak List P an H L] on ata -
P inPi How are decoys specified?:
Statistical Validation | By identifiar prafix =
= Mayu Select Select

identified PSMs at Decoy Prefix: _

spacified FOR (must have REV

been searched with decoy
T

Column containing identifiers.:

s Compute False Discovery
Rate (FDR] and append it
to tabular data.

cify score column? (Not yet implemented!):

Allows more percise handling of tied hits.

Tabb Tools
Metaproteomics FDR Typa:
Cet Data I Global (conservative) =]
PROTEOMICS: COMMUNITY _Scaling:
Dpen MS _Z.EI |
Protk Scaling factor used for FOR calculations, for a balanced databa:
s Create Decoy Database
(random) Creates a m
random protein database
with sirmilar Arsnarkias ke

This will give you an output with a column with false discovery rate. You can use the ‘eye’ icon to visualize your data.
You can use the text manipulation tools such as ‘Add column” and “cut” in order to visualize your data better.
Go to Tools —> Text manipulation —> Add column. Ensure that the correct file (number 13 in the list) is chosen as a

dataset. Change Iterate column to yes and click on execute.

Add column (version 1.0.0)

Add this value:
E |
to Dataset:

| 13: Sort on data 11 with FDR =
Dataset missing? See TIP below

Iterate?:

IYEE;I

This will give you your 14th history item. Use the eye icon to confirm that a column has been added at the end of the
file.

Next, we will cut columns 1, 10 12 and 13 from history dataset number 14. For this go to Tools —> Text manipulation
—> Cut. Ensure that the correct file (number 14 in the list) is chosen as a dataset. Type in cl,c10,c12,c13 in ‘cut
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columns’ box and press execute.

Cut (version 1.0.1)

Cut columns:
cl,c10,c12,cl13
Delimited by:

Tab ;I

From:

I 14: Add column on data 12 ;I

This will give you 15th history dataset.

2.12. False Discovery Rate Analysis
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History 1
o= =
Galaxy-P 101 1.0 GB
15: Cut on data 14 @ R

14: Add column on data @R
13

13: Sort ondata 11 with @& §
FDR

12: Sort on data 11 ®

11: Table peptide prophet @& 1 -4
Rawl01.pep.xml.csv

10: Convert ProtXMLto @& §
Tabular on data 9

9: ® R
protein prophet.peptide prophet.
X!'tandem vs Target Decoy Human
Contaminants.Peaklist
RawD10.Peaklist

Rawl101.pepXML.pep.xml.protXML

8: peptide prophet @ R
Rawl01.pep.xml

7: X'tandem vs Target ® [ R
Decoy Human
Contaminants.Peaklist
RawD10.Peaklist Rawl01.pepXML

6: Peaklist Raw101 @ R
5: Raw101.RAW @ R
4: @ B

Target Decoy Human Contamina
nts on data 3

3: Merged Human UniProt @ § 32
cRAP

2: CRAP @ B
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If you click on the Visualize / scatterplot icon you will see a scatterplot controls in the central window.

Data Controls Plot Controls Statistics

Use the following controls to change the data used by the chart. Use the 'Draw’ button to render (or
re-render) the chart with the current settings.

Data column for X: I column 2 ;l

Data column for ¥: I column 3 ;I

Include a third column as data point IDs? [

The== will b= di=play=d {along with the x and v vahs=s)] when you hover over a data point
Diraw I

Keep the Data column X: column 3 and change Data column Y: column 4. Click on Draw.

Scatterplot of "Cut on data 17*

[ —] - -
{ Data Controls | Plot Controls  Statistics P
E 450- "
L4
e
Use the following controls to change the dats used by the chart. Use the 'Draw button to render (or /4‘
re-render) the chart with the current settings. 200 .
Data column for X: Im‘umn 3 =l as0- '.' et
Data column for ¥ | column 4 | I'
Include a third column as data point 1Ds? [ 200- '.. -
Thesz will be dizplay=d [sleng with the x and y values) when you hover aver 2 dats point r
* 250
Draw | = .
B

200-

150 I

100

50

o T T T
0.00 0.10 0.z0 0.30

saium 3

This will give you a ROC plot that gives you statistics and number of identifications at various levels of FDR.

= »
Data Controls  Plot Controls | Statistics ..'
450 i
-
-
By column: -
y © :
200 o f"
x v ”
L
Count |472 472 250 f'
Min |0 1 ]
Max |0.302128 472 200- Gov® '
Sum | 25.37573299399397 111628 r'
Mean 0.076228247B8135586 236.5
= 250 ™
Median |0.012931 118 %
200-
150 l
100
50
1 T T T
o.00 0.10 0.20 ar
ooumn 3 |
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Go to “Plot Controls” Tab and change the controls on your chart. Relabel X axis as “FDR” and Y-axis as ‘NUMBER
OF SPECTRAL IDs”. Click on Draw to render the chart on current settings.

If you scroll on the graph, you will be able to see that 144 spectra were identified in this dataset before the first reverse
match was encountered (FDR of 1.3%). Thus, 144 spectra were identified below 1% global FDR.

Statistics

Data Controls Plot Contrals

Use the following controls to how the chart is displayed. The slide controls can be moved by the mouse

or, if the 'handle’ is in focus, your keyboard's smow keys. Move the forus between controls by using the
tab or shift+tab keys on your keyboard. Use the 'Draw button to rander (or re-render) the chart with the
current settings.

Size of data paint: 4

= represe

Animats graph transitions

Unehesk this tz dizabiz the animatizns u=d on the gragh

Graph width: 500

ng graph margins ang axes)

Graph height: 500

aph margins and axes)

Re-label the ¥ axis:  FDR

Re-label the ¥ axis:  NUMBER OF SPECTRAL IDs

[ Draw [

2.13 Understanding Galaxy Histories

In Galaxy, your analyses live in histories such as this one:

a50— ..',
“

g

200-
Z50- .‘

zoo-

NUMBEROF SPECTRAL ID5

150—

w00 |0.013793, 145

50

0.00 0.10 0.zo 0.30
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History 1
o= =
Galaxy-P 101 1.0 GB
15: Cut on data 14 @ R

14: Add column on data @R
13

13: Sort ondata 11 with @& §
FDR

12: Sort on data 11 ®

11: Table peptide prophet @& 1 -4
Rawl01.pep.xml.csv

10: Convert ProtXMLto @& §
Tabular on data 9

9: ® R
protein prophet.peptide prophet.
X!'tandem vs Target Decoy Human
Contaminants.Peaklist
RawD10.Peaklist

Rawl101.pepXML.pep.xml.protXML

8: peptide prophet @ R
Rawl01.pep.xml

7: X'tandem vs Target ® [ R
Decoy Human
Contaminants.Peaklist
RawD10.Peaklist Rawl01.pepXML

6: Peaklist Raw101 @ R
5: Raw101.RAW @ R
4: @ B

Target Decoy Human Contamina
nts on data 3

3: Merged Human UniProt @ § 32
cRAP

2: CRAP @ B

2 33.HyraandRiing Galaxy Histofidd =
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Histories can be very large, you can have as many histories as you want, and all history behavior is controlled by the
Options button on the top of the History pane:

Historw s
HISTORY LISTS

OE saved Histories

Galal Histories Shared with Me
CURRENT HISTORY

15

Create New =

14: A Clone
Copy Datasets

13: § Share or Publish

FDR | Extract Workflow

Dataset Security

Show Deleted Datasets |
11: T Show Hidden Datasets
pept Purge Deleted Datasets
Show Structure B
10: € Ewport to File

Delata

Delete Permanently
protd OTHER ACTIONS

Import from File

ide prophet @® 75
Rawl0l.peo.xmil

Many of the options here are self explanatory. If you create a new history, your current history does not disappear. If
you would like to list all of your histories just choose Saved Histories and you will see a list of all your histories in the
central window pane:

Saved Histories

| search histery names and tags

Advanced Search

rﬂame

M [ Galaxy-P 101 -]

Switch

| Clal view
. Share or Publish

I- @ Rename

Delete
|- msid
| Delete Permanently

2.14 Converting Histories to Workflows

One of the history options listed is very special. It allows you to easily convert existing histories into analysis work-
flows. Why would you want to create a workflows out of a history? To redo the analysis again with minimal clicking.

Lets take a look at the history again:
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History 1
o= =
Galaxy-P 101 1.0 GB
15: Cut on data 14 @ R

14: Add column on data @R
13

13: Sort ondata 11 with @& §
FDR

12: Sort on data 11 ®

11: Table peptide prophet @& 1 -4
Rawl01.pep.xml.csv

10: Convert ProtXMLto @& §
Tabular on data 9

9: ® R
protein prophet.peptide prophet.
X!'tandem vs Target Decoy Human
Contaminants.Peaklist
RawD10.Peaklist

Rawl101.pepXML.pep.xml.protXML

8: peptide prophet @ R
Rawl01.pep.xml

7: X'tandem vs Target ® [ R
Decoy Human
Contaminants.Peaklist
RawD10.Peaklist Rawl01.pepXML

6: Peaklist Raw101 @ R
5: Raw101.RAW @ R
4: @ B

Target Decoy Human Contamina
nts on data 3

3: Merged Human UniProt @ § 32
cRAP

2: CRAP @ B

2 44 Hegaea iy Eiiories to WorRilgws®
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You can see that this history contains all steps of our analysis. So by building this history we have actually built a
complete record of our analysis with Galaxy preserving all parameter settings applied at every step. Wouldn’t it be
nice to just convert this history into a workflow that we’ll be able to execute again and again? This can be done by
clicking on Options button and selecting Extract Workflow option:

Historwe i - 3
HISTORY LISTS ]

L= saved Histories
Galal Histories Shared with Me
CURRENT HISTORY

Create New
14: & Clone

Copy Datasets

13:§ Share or Publish
Extract Workflow

Dataset Security

Show Deleted Datasets
11: T Show Hidden Datasets
Purge Deleted Datasets
Show Structure | |
10: £ Export to File
Delata

o Delete Permanently
proti OTHER ACTIONS
et R:

Import from File

a: ide prophet @ 05
Rawl0l.pep.xml

The center pane will change as shown below and you will be able to choose which steps to include/exclude and how
to name the newly created workflow. In this case I named it “Galaxy-P 101 Workflow™:
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The following list contains =ach tool that wes run to create the datasets in your current history. Plesse select those that you wish to includs in the workflow.

Tools which cannot be run interactively and thus cannat be incorporated into a workflow will be shovm in gray.

Workflow name

Galasxy-P 101 Workflow

Craate Workflow | Checkall | Uncheckll |

Tool History items created
1: Human UniProt
Upload File
>
This & [ Trest as input dataset
2: cRAP
Upload File
>
This teol cannot be used in workflows .
[V Treat as input dataset
Merge FASTA Databases
> 32: Merged Human UniProt cRAP
[¥ Include "Merge FASTA Databases” in workflow
Create Decoy Database (reverse)
> 4: Target_Decoy_Human_Contaminants
[¥ Include "Create Decoy Database (reverse)" in workflow
5: Raw101.RAW
Upload File
>
This teol cannot be used in workflows [ Treat as input dataset
msconvert3_raw
> 6: Peaklist Raw101
[¥ 1nclude "msconvert3_raw' in workflow
XITandem MSMS Search
> 7: X!Tandem_vs_Target_Decoy_Human_Contaminants.Peaklist Raw101.Peaklist Raw101.pepXML
[¥ Include "X!Tandem MSMS Search” in workflow
Peptide Prophet
> 8: peptide_prophet Raw101.pep.xml
[¥ Include "Peptide Prophet” in workflow
Protein Prophet
> 9: protein_prophet.peptide_prophet Raw101.pep.xml. protXML
[¥ 1nclude "Protein Prophet” in workflow
Convert ProtXML to XLS
> 10: Convert ProtXML to XLS on data 9
[¥ Include "Convert ProtXML to XLS" in workflow
PepXML to Table
> 11: Table peptide_prophet Raw101.pep.xml.csv
[¥ Include "PepXML to Table" in workflow
Sort
> 12: Sort on data 11
¥ Include "Sort" in vorkflow
Compute False Discovery Rate (FDR)
> 132: Sort on data 11 with FDR
[¥ Include "Compute False Discovery Rate (FDR)" in workflow
Add column
> 14: Add column on data 13

[¥ 1nclude "Add column” in workflow

Once you click Create Workflow you will get the following message: “Workflow ‘Galaxy-P 101 Workflow’ created
from current history”. But where did it go? Click on Workflow link at the top of Galaxy interface and you will a list
of all workflows with “Galaxy-P 101 Workflow” listed at the top:

If you click on a triangle adjacent to the workflow’s name you will see the following dialogue:
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e

Your workflows

Galaxy-P 101 Workflow - 1

Run

| Workflow cony  Share or Publish
Download or Export
| Waorkflow con

Clone

| Workflow fror Rename
View
| Warkflow con;

Delata
P |

Click Edit and the workflow editor will launch.

Loading workflow editor...

It will allow you to examine and change settings of this workflow as shown below. Note that you can click on each
box so that you can see parameters of this tool on the right pane. This is how you can view and change parameters of
all tools involved in the workflow.

Workflow Canvas | Galaxy-P 101 Workflow Options +
Input dataset 3 Marga FASTA Databases @i By Breliess XiTandem MSMS Saarch ¢ || Paptide Prophat Ersiem B et ® Convert ProtXML to XLS 3§ | | Computa Falsa Disc
reveree Fom.

output Input FASTA Fila(s) 1 > FASTA U ! Uplosded FASTA file Raw Search Rasults Paptida Prophat Results Prot XML Input (FoR)

File FASTA Input Input Table

MSMS File output (peptideprophet_pepxr output (protxml) output (protxml )

Input FASTA Fila(s) 2 > FASTA utput (fasta) output

o output (rave_pepsml)
et % L % PepXML to Table 3¢ Sort %
output Input File Sort Query

output (pepsml.cev) out_fila1

[ ™
output

You can also reorganize your workflow so that it makes intuitive sense. For example, I have compartmentalized this
workflow as follows. However, as in any form of art — this is not the only way of representing your workflow. Re-
architecture as the best way you wish to.
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Workflow Canvas | Galaxy-P 101 - input

Options ~
Protein Database Dovwnloader $2
M FASTA Datab:
output_database (fasta) =<2 stshases x
Input FASTA Fila(s) 1 > FASTA
File
Input FASTA File(s) 2 > FASTA Craste Decay Database %
Protein Database Downloader § File (reversa)
cutput_database (fasta) output (fasts) FASTA Input
output (fasts)
Protein Prophet 2
Peptide Prophet Results Convart ProtXML to Tal
output (protxml) Prot XML Input
output (protxml.tsv)
X'Tandem MSMS Search §§
Input dataset
= ® msconvert3_raw ® 3 Uploaded FASTA file
output Thermo Finnigan RAW Input MSMS File
output (mzml, maxml, ms2, atmt v el
mgf)
tandem_output (xml)
Peptide Prophat 9

Raw Search Results

output (peptideprophet_pspxml)

PepXML to Table 3¢
Input File

output (pepxml.csv)

Sort ®

Sort Query
out_file1
Compute False Discove
(FDR)
Input Table

output

Add column

to Dataset

[

For this tutorial, we are going to reformat the workflow by replacing the earlier part of database creation with an input
database. For this we excise the part where uploaded FASTA file merges with the X! Tandem search step.
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=

put FASTA File(s) 2 = FASTA Create Decoy Database =4
EY (revarsa)
tput (fasta) am > FASTA Input

output (fasta) 'I,--" "

| x'Tandem MSMS Search #

‘ 4 3% Uploaded FASTA file
n RAW Input 5 =——— % MSMS File
mzxml, ms2, - B

t

output (raw_pepxml) [

You can delete all the steps involving FASTA database creation. Delete one step at a time...

Your workflow now will look like this. Note that the Uploaded FASTA file has not input.

X!Tandem MSMS Search §8

{2) Uploaded FASTA file

|
[

= MSMS File

output (raw_pepxml)

Input dataset b-3 | | msconvert3_raw b3
1 1
output [ ) Therme Finnigan RAW Input
e |

tandem_output (xml)

output (mzml, mzxml, ms2, mgf)

‘ Peptide Prophet

%

I
Raw Search Results

output (peptideprophet_pepxml)

PepXML to Table

) Input File

output (pepxml.csv)

Protein Prophet

2

Peptide Prophet Results Convert ProtXn

output (protxml)

Prot XML Input

output (protam

%

Sort ®
sort Query
m‘Lmel
Compute False Discovery|
(FDR)
Input Table | ]
output - 1
—
Add colu L
to Datas [ ]
out_filel

You can now scroll down to the left bottom corner of the screen and click on inputs. ‘Input dataset’ option will show

up. Click on it.
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e

= Input dataset

Once this is done, ‘input dataset” box will appear in the central Window pane.

Input dataset =

output

Position the Input dataset pane in such a way that you can join the output arrow on this box with the input arrow for the
X!tandem search. In other words, we are providing a FASTA database input for the X!tandem search. The significance
of this step will become clearer when we use this workflow.

Input Dataset b=
output
I |
Protein Prophe
) Peptide Prophe
output (protxr
| XiTandem MSMS Search §§
Input dataset ® | msconvert2_raw n

7 Uploaded FASTA file

output

Thermo Finnigan RAW Input

I MSMS File

output {mzml, mzxml, ms2,

| output (raw_pepxml)
mgf) |

| tandem_output (xml)

| Peptide Prophet "

Raw Search Results

| output (peptideprophet_pepxml)

| PepXML to Table n

7 Input File

output (pepxml.csv)

Below is mentioned one of the many things that you can do with workflows. When workflow is executed one is usually
interested in the final product and not in the intermediate steps. These steps can be hidden by mousing over a small
asterisk in the lower right corner of every tool box:

el e Fag this as a workflow output.
All non-flagged outputs will be

Thermeo Finniga hidden.

output {m=ml, mzxml, msZz,
maf)

Yet there is a catch. In a newly created workflow all steps are hidden by default and default behavior of Galaxy is that
if all steps of a given workflow are hidden, then nothing gets hidden in the history. This may be counterintuitive, but
this is done to decrease the amount of clicking if you do want to hide some steps. So in our case if we want to hide all
intermediate steps with the exception of the last one we will click that asterisk in last step of the workflow:
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IPUT 1aDe

tput

Add column

to Dataset

out_filel
Cut ®
From
out_filel (tabular) = 2

Once you do this the representation of the workflow in the bottom right corner of the editor will change with these
steps becoming orange. This means that these are the only steps, which will generate datasets visible in the history:

Workflow Canvas | Galaxy-P 101 - input

Options ~
Input Dataset 3%
output Protein Prophet 32
[
Peptide Prophet Results | Convert ProtXML to Tabular 3¢
L
XITandem MSMS Search output (protxml) > Prot XML Input
Uploaded FASTA file output (protxml.tsv) -
MSMS File
| Input dataset 5 ‘ ‘ T vl e 2 DUtDUt(raw pepxml) S—
11T N N
| output : Therma Finnigan RAW Input tandem_output (xml) ]
output (mzml, mzxml, ms2,
magf)
| Peptide Prophet =
I
Raw Search Results
output (peptideprophet_papsxmi)
PepXML to Table 8
Input File
output (pepxml.csv)
Sort E
Sort Query
out_file1
Compute False Discovery Rate B
(FDR)
|
Input Table
output
Add column 2
to Dataset
out_file1
From Fr
out_filel (tabulzr) ®
_—
-

Right now both inputs to the workflow look exactly the same. This is a problem as will be very confusing which
input should be FASTA files and which should be RAW file. In your workflow you will see that the top input dataset
connects to the X!tandem search , so it must correspond to the Target Decoy database. If you click on this box you
will be able to rename the dataset in the right pane:
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Details

Input dataset

Name:

Target Decoy FASTA

Edit Step Attributes

Annotation / Notes:

Target Decoy FASTA

Add an annotation or notes to
this step; annotations are
available when a workflow is
viewed.

... and Thermo RAW file (second input).

Dratails

Input dataset

Name:

Thermo RAW File

Edit Step Attributes

Annotation / Notes:
RAW file from
Thermefinnigan LTQ/
Qrbitrap instrument.

Add an annotation or notes
to this step; annotations are

available when a workflow is
viewsad.

Feel free to annotate as many steps as you can so that it can be easier for you to revisit and understand the workflow
or easier to share it with others.

Renaming outputs

Finally let’s rename the workflow’s output. For this click on one of the last datasets (“Convert ProtXML to Tabular”)
and in the Edit Step Actions dialogue box select “Rename Dataset”.
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Details

Tool: Convert ProtXML to
¥LS

Version: 0.1.0

Prot XML Input
Data input 'input' {prot.eml}

Edit Step Actions

Rename Dataset ;I
uutput;l Createa

Rename Dataset
on output u

New output nanme:

| Protein Table.

This action will rename the
result dataset.

Add actions to this step:
actions are applied when this
wiorkflow step completes.

Edit Step Attributes

Annotation / Notes:

Add an annotation or notes

to this stepr annotations are
available when a workflow is
viewead.

Similarly, for the other output dataset (“Cut”) , click on the box and in the Edit Step Actions dialogue box select
“Rename Dataset”.
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Deatails

Tool: Cut

Version: 1.0.1

Cut columns: ¥

c2,cl10,cl12,cl13

Delimited by: ¥
Tab ;I

From
Data input 'input’ (txt)

Edit Step Actions

Fename Dataset ;I
uut_filel;l Create |

FRename Dataset
on out_filel e

New output name:
| FDR|ROC curve.

This action will rename
the result dataset.

#dd actions to this step;
actions are applied when
this workflow step
completes.

Remember you can highlight as many “outputs” as you want to and rename them for sake of a more complete and

shareable annotation.

Save! It is important...

Now let’s save the changes we’ve made by clicking Options (top of the center pane) and selecting Save:

| Run El

Edit Attributes mn:

Auto Re-layout

Close

: c2, 1:']'.III C
[ T N R

2.15 Applying Workflows to Your Data

Let us use this workflow on another Raw file. For this go to Analyze Data —> History options icon and select create

new history.

2.15. Applying Workflows to Your Data
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Using 262.0 G

Historw
HISTORY LISTS

W= saved Histories
Galal Histories Shared with Me
CURRENT HISTODRY

14: A Clone
Copy Datasets

13:§ Share or Publish
FDR  Euwtract Workflow

Dataset Security

Show Deleted Datasets | |
11: T Show Hidden Datasets
pept Purge Deleted Datasets
Show Structure E
10: € Export to File

Delete

Qs Delete Permanently
protd OTHER ACTIONS

Import from Fila

id rophet
xml

&
E
@
=3
H

I Fﬂ
g
=

X'Tandem ws Target Decoy H
uman Contaminants. Peaklist

Rawil0l.Peaklist
Rawl0l.pepXML

6: Peaklist Rawi101 & K
5: Rawil01.RAW @®
4z @ [ H
Target Decoy Human Contami
nants

3: Merged Human @ [ 5
UniProt cRAP

2: cRAP @& 75
1: Human UniProt @ {5

This will create a new history with no datafiles.

History iF
v A=
Unnamed history 0 bytes

€ our history is empty. Click
'Get Data' on the left pane to
start
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Let us name this history Galaxy-P 102.

History £ 4
o= :
|Galax\rhl} 102 q] bytes

€ vour history is empty. Click
'Get Data' on the left pane to
start

We will transfer some of the files from our Galaxy-P 101 history to Galaxy-P 102 history. For this go to History
options icon and click on copy datasets.

Histo S
HISTORY LISTS L

W= Saved Histories
Unna Histories Shared with Me
CURRENT HISTORY

Create New

Clone

Copy Datasets

Share or Publish
Extract Warkflow
Dataset Security

Show Deleted Datasets
Show Hidden Datasets
Purge Deleted Datasets
Show Structure

Export to File

Delate

Delete Parmanently
OTHER ACTIONS

Import from File

This will open up a new central window pane. Transfer the target-decoy FASTA file from Galaxy P-101 (Source
History) to Galaxy-P 102 (Destination history).
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[0 Copy any number of history items from one history to another. ]
Source History: — Destination History:
| 5: Galaxy-P 101 (current history) j
| 2: Galaxy-P 102 -

[T 1: Human UniProt
Choose multiple histories

[T 2: CRAP

[ 3: Merged Human UniProt cRAP

— QR —
[ 4: Target_Decoy_Human_Contaminants on data
3

New history named:

[T 5: Rawi01.RAW
[ 6: Peaklist Raw101

[ 7: X'tandem vs Target Decoy Human
Contaminants.Peaklist Raw010.Peaklist
Raw101.pepXML

[ 8: peptide_prophet Rawi01.pep.xml

[T 9: protein_prophet.peptide_prophet.X!tandem
vs Target Decoy Human Contaminants.Peaklist
Raw010.Peaklist Raw101.pepXML.pep.xml.protXML

[ 10: Convert ProtXML to Tabular on data 9

11: Table peptide prophet Rawi01.pep.xml.csv
12: Sort on data 11

13: Sort on data 11 with FDR

14: Add column on data 13

(I R R

15: Cut on data 14

Copy History Items |

This will transfer the target-decoy FASTA file in your current history.

History e g

Q- Zi=

Galaxy-P 102 116.0 MB

1: ® (K
Target Decoy Human_Contamin
ants on data 3

Click on Galaxy-P 102 history and let us download another raw file from the following link:
https://netfiles.umn.edu/users/pjagtap/Galaxy-P 101/Raw102.RAW
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Upload File (version 1.1.3)

File Format:

|Autu-dete-|:t
Which format? See help below

File:
| Browse... |

TIP: Due to browser limitations, uploading files larger than 21

URL [ Text:

https://netfiles.umn.edu/users/pjagtap
/Galaxy-P 101/Rawl0Z.RAW

Here you may specify a list of URLs (one per line) or paste th

Files uploaded via FTP:
File
Your FTP uplead directery contains ne files.

This Galaxy server allows you to upload files via FTP. To uplo

Conwvert spaces to tabs:

I_ Yes

Use this option if you are entering intervals by hand.

Genone:

|C|icl-c to Search or Select

Clicking on Execute will add second file to this history.

2.15. Applying Workflows to Your Data
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History e

o Zi=

Galaxy-P 102 116.0 MB

3 2: ® ()R
https:/ /netfiles.umn.edu/users

/pjagtap/Galaxy-P
101/Rawi102.RAW

1: WA
Target Decoy Human_Contamin
ants on data 3

Rename the RAW file by using the pencil icon. Change the name to “Raw102”.
Now, for your rerun, your history template with 2 files (Galaxy-P 102) is ready.

History e

o Zi=

Galaxy-P 102 317.8 MB

2: Raw102.RAW ® (R
1: ® (R

T_arget Decoy Human_Contamin
ants on data 3

Go to Workflows tab and open the Galaxy-P 101 workflow and select “Run”.
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Your workflows

| Galaxy-P 101 Workflow |
—————  Edit

| Galasxy-P 10 :

| workflow cor  Share or Publish

[ Workflow cor Download or Export

Clone
| workflow fra Rename i
| Waorkflow cor Miswe

Delete

I aae v v

Select appropriate files from your current history as inputs.
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Step 1: Input dataset

RAW

RAW Input L
2: Raw102.RAW [

type to filter

Step 2: Input dataset
Target Decoy FASTA

Target Decoy FASTA L

1: Target_Decoy_Huma..s on data 3 j

type to filter

Step 3: msconvert3 raw (version 0.1.0)

Step 4: X!Tandem MSMS Search (version 1.0.0)

Step 5. Peptide Prophet (version 1.1.0)

Step 6: PepXML to Table (version 1.0.0)

Step 7: Protein Prophet (version 1.0.0)

Step 8: Sort (version 1.0.1)

Step 9: Convert ProtXML to Tabular (version 0.1.0)

Step 10: Compute False Discovery Rate (FDR) (version 0.1)

Step 11: Add column (version 1.0.0)

465tED 12: Cut (Veq.gqatﬁr a_._ﬁ_a?}y-P 101 - Building Up and Using a Proteomics Workflow

I <end resulirs to 3 new history
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You can choose to run this in the same history or create a history of “only outputs” in a new history from this analysis.
For this tutorial, we will run it in the same history.

Click on Run Workflow. Luckily you do not have to wait as Galaxy will automatically start jobs once uploads have
ended.

o Successfully ran workflow "Galaxy-P 101 - input”. The following datasets have been added to the queue:

=]

Raw102.RAW

Target_Decoy_Human_Contaminants on data 3

msconvert3_raw on data 2

¥ITandem_vs_Target_Decoy_Human_Contaminants on data 3.msconvert3_raw on data 2.msconvert3_raw on data 2.pepxML

peptide_prophet. X1Tandem_vs_Target_Decoy_Human_Contaminants on data 3.msconvert3_raw on data 2.msconvert3_raw on data 2.pepXML.pep.xml
peptide_prophet.X1Tandem_vs_Target_Decoy_Human_Contaminants on data 3.msconvert3_raw on data 2.msconvert3_raw on data 2.pepXML.pep.xml.csv
protein_prophet.peptide_prophet.XTandem_vs_Target_Decoy_Human_Contaminants on data 3.msconvert3_raw on data 2.msconvert3_raw on data 2.pepXML.pep.xml.protXML
Sort on data 6

Convert ProtXML to Tabular on data 7

10: Sort on data 6 with FDR

o e N WA

11: Add column on data 10
12: Cut on data 11
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History 0
o A=
Galaxy-P 102 317.3 MB

$2 12: Cut on data 11 @ R’

& 11: Add column on data ® § ¥
10

42 10: Sort on data 6 with ® § ¥
EDR

42 9: Convert ProtXMLto ® {§ &
Tabular on data 7

42 8: Sort on data 6 @ K

-V H ® %
protein prophet.peptide prophet.
X!Tandem vs Target Decoy Hu
man Contaminants on data
3.msconvert3 raw on data
Z2.msconvert3 raw on data

2.pepXML.pep.xml.protXML

& 6: ® %)
peptide prophet.X'Tandem vs Ta
roet Decoy Human Contaminant
s on data 3.msconvert2 raw on
data 2.msconvert3 raw on data
2.pepXML.pep.xml.csv

& 5 ® %"
peptide prophet.X!Tandem vs Ta
rget Decoy Human Contaminant
s on data 3.msconvert? raw on
data 2.msconvert3 raw on data
2.pepXML.pep.xml

- H @ %)
X!Tandem vs Target Decoy Hu
man Contaminants on data
3.msconvert3 raw on data
Z2.msconvert3 raw on data
2.pepXML

“ 3: msconvert3 rawon @ § ¥
data 2

2: Rawl102.RAW @ %

3%
48arget Decoy Human EDaRIRLiAa Galaxy-P 101 - Building Up and Using a Proteomics Workflow
nis on data 3
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Get coffee

As we mentioned above this will take some time, so go get coffee and then you will see this. Note that because all
intermediate steps of the workflow were hidden, once it is finished you will only see the final dataset.

History £
LB

Galaxy-P 102 850.2 MB
27: FDR ROC curve. &® [ i
3% Protein Table. @& [ %
3: Rawl102.RAW & @ #®

2.15. Applying Workflows to Your Data
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CHAPTER 3

FTP

Galaxy provides the ability to upload files via the web interface (under the tool menu “Data Source” -> “Upload”),
however this only allows one to upload one file at a time and web browsers generally limit uploads to 2 GB. Galaxy-P
provides an FTP server that can be used to upload more and larger files.

3.1 Uploading Files

Property Value

Hostname usegalaxyp.org

Connection | FTPS / FTP + Encyrption

Username E-mail used to register Galaxy-P account.
Port 990

The following walkthrough demonstrates how to connect to Galaxy-P FTP server using WinSCP and upload RAW
data files. WinSCP is demonstrated because it is a popular piece of freely available software, but many other tools
could be used as long as they support FTP with encryption.

¢ Open WinSCP, specify connection information, and then click login. You may also want to give this connection
a name and save it for later reuse.
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2 WinSCP Login

Session —Seszion
.Sh:ured FEEHONG File protocal: Ercroption:
Errvironment — -
‘. Directaries FTF j ISSL Explicit encryption j
Pref
RIsrEnies Host name: Part number:
=l
330 =
Uzer name: Pazzword:
Iimchiltun@gmail.cum I
Aocount:
Iusegala:-:yp [T Anonymaus login
Select color
[T &dvanced options
About... | Languages | Login Save.. |v| Cloze |

 The first time you connect, you will likely be prompted to store the hosts SSL certificate, do this by clicking
‘4Yes7’.
Warning

The zerver's certificate iz not known, ou have no guarantee that the zerver iz the computer pou think it iz, Server's cedificate details follov:
lzzuer

- Organization; Internet2, InCommon, InCommon Server Cé

- Location: LS

Subject:

- Organization: University of Minnesota, Minnesota Supercomputing Institute, galaxyp. msi.umn. edu

- Location: US, MM, Minneapolis

- Other: postalCode=55455;

Yalid: 8/21,/2012 12:00:00 &M - 8/21/2015 11:59:53 PM

Fingerprint [SHA1): c3:14:00:71:0d:d2: 22:98:92.05, 83 7 d a2: 67 16:9a:01. 88: 3621

Surmmary: Unable to get local iszuer certificate. The emor occured at a depth of 1 in the certificate chain.

IF wou brust thiz certificate, prezz Tes To connect without storing certificate, prezs Mo, To abandon the connection press Cancel,

Continue connecting and store the certificate?

Ha Cancel LCopy Key Help

* When prompted for your password, please enter it and click “Okay”.

52 Chapter 3. FTP



Using Galaxy-P Documentation, Release 0.1

o gPassword - imchilton@gmail.com@usegalaxyp.org

Connecting to uzegalasyp.org 330 .

551 connection establizhed. 'waiting for welcome message. .

Pazzword:

Connected with uzegalawyp.org: 330, negatiating S5L connection....

k. Cancel

Help

« If everything has gone well, you should now see two file browsers. The one on your left is your computer’s files
and the one on the right is your Galaxy-P staging area (which should be initially empty).

Using the left file browser, navigate to the files you wish to upload and select them.

=T 3|t

e i 7 o Srcry P55 F5Prpares i3t

8 m @ owa

* Drag and drop these files to the right panel to begin the transfer and wait as the files are transfered.

16% Copying Ed |

Cancel
Minimize
File: A DawnloadssA1_ATP_T.Hahw
Target: / Onece finizhed:
[ ] [Stayide =]
Time left; 00026  Time elapzed: 0:00:05

Bytes transferred:  BO0348 KB Speed:

11,868 KiB/s Speed [KiBr2):

|

[Unlimited = |

 Verify your files have been copied.

3.1. Uploading Files
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pehtragrtconuesbmpes | |
s e -

OBarENE U

2 F2norame 7 FER 35y Feers 7 oDty 3Dk 529 g 310 it

s
i

[TRE- T

8 me @ oen |

* These files may now be imported into a Galaxy history using the “Data Source” -> “Upload” tool. When filling
out the upload information, instead of using the browser upload option simply check the uploaded files in the
“Files uploaded by FTP” section.

Likewise, these a multiple file dataset can be created using these files and the “Multiple File Datasets” ->
“Upload and merge” tool.

€ | B https://galaxyp.msi.umn.edu

Analyze Data

Tools

Upload and merge (version 1.1.3)

search tools

GALAXY CORE

Get Data

Send Data

Multiple File Datasets

Upload aqg;[l:ferge multiple
files to on& dataset.
Merge Standard Datasets

(Linked) into Multiple File
Dataset

Merge Standard Datasets
{Copied) into Multiple File
Dataset

Split Multiple File Dataset into
standard datasets (one per
file).

Text Manipulation
Filter and Sort

Join, Subtract and Group
Statistics

Graph /Display Data
Multiple regression
Multivariate Analysis
Motif Tools

Multiple Alignments
Metagenomic analyses
Phenotype Association
FASTA manipulation

PROTEOMICS: GALAXY-P
Peak List Processing
ProteinPilot

Statistical Validation
Quantitation

MaxQuant

Bumbershoot Tools
Metaproteomics
Proteogenomics

Get Data

-

File Format:
raw v
Which format? See help below

Dataset Name:

Files:

Choose Files | No file chosen
TIP: Due to browser limitations, uploading files larger than 2GB is guaranteed to
fail. To upload large files, use the URL method (below) or FTP (if enabled by the
site administrator).

URL/Text:

s
Here you may specify a list of URLs (one per line) or paste the contents of a file.

Whole directories containing files uploaded via FTP will be merged:
File Size Date

Your FTP upioad directory contains no files.

This Galaxy server allows you to upload files via FTP. To upload some
files, log in to the FTP server at galaxyp.msl.umn.edu using your
Galaxy credentials (email address and password).
Files uploaded via FTP:
File Size Date

# Al_ATP_1.RAW 128.2 MB 05/19/2013 12:28:29 AM
# AL_ATP_2.RAW 123.6 MB 05/19/2013 12:28:57 AM
# ALl_ATP_3.RAW 115.7 MB 05/19/2013 12:29:24 AM

This Galaxy server allows you to upload files via FTP. To upload some
files, log in to the FTP server at galaxyp.msi.umn.edu using your
Galaxy credentials (email address and password ).

Convert spaces to tabs:
Yes
Use this option if you are entering intervals by hand.

Genome:

unspecified (7?) v

-
https://galaxyp.msi.umn.edu/tool_runner?tool_id=multi_upload1

Al_ATP PeptideShaker

&=

© vour history is empty. Click 'Get
Data' on the left pane to start
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3.2 See Also

» Galaxy Project Documentation on FTP Uploads

3.2. See Also
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CHAPTER 4

Multiple File Datasets

4.1 Introduction

Traditional Galaxy workflows require a fixed number of input files and may produce a large number of intermediate
files per input. Additionally, Galaxy renames datasets with each step, making tracking samples or fractions across long
workflows very difficult. These issues together make Galaxy a problematic platform for workflows and application
areas that require dealing with a large number of files. The prevalence of fractionated samples in mass spectrometry
makes proteomics such an application area.

Galaxy-P however utilizes an extension to the core Galaxy framework called “Multiple File Datasets” designed to
address these shortcomings in Galaxy. In simple terms, Galaxy-P can group many similar files into a single dataset
(called a multiple file dataset). Normal Galaxy tools can then use these datasets and produce multiple file datasets of
their own, operating on each item in parallel. In addition to keeping the number of datasets in the Galaxy managable,
this allows for the creation of workflows that can operate over any number of files and the individual files in the
multiple file dataset are given consistent, trackable names across such complex workflows making sample tarcking
trivial.

4.2 Creating a Multiple File Dataset

Once you have an initial multiple file dataset, most tools when operating on these datasets will in return produce
multiple file dataset outputs. So for most proteomic workflows, the first step is simply to create a multiple file RAW
dataset or a multiple file peak list (e.g. mzML or mgf) dataset.

There are several ways to do this.

* One can use the “Multiple File Datasets” -> “Upload and Merge” tool along to create a multiple file datasets
from files or a directory of files uploaded via FTP.
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€ | 8 https://galaxyp.msi.umn.edu

Analyze Data

Tools

search tools

GALAXY CORE

Get Data

Send Data

Multiple File Datasets

= Upload aqg;[l:ferge multiple
files to on& dataset.

Merge Standard Datasets

(Linked) into Multiple File
Dataset

Merge Standard Datasets
{Copied) into Multiple File
Dataset

Split Multiple File Dataset into
standard datasets (one per
file).

Text Manipulation

Filter and Sort

Join, Subtract and Group
Statistics

Graph /Display Data
Multiple regression
Multivariate Analysis

Motif Tools

Multiple Alignments
Metagenomic analyses
Phenotype Association
FASTA manipulation

PROTEOMICS: GALAXY-P
Peak List Processing
ProteinPilot

Statistical Validation
Quantitation

MaxQuant

Bumbershoot Tools
Metaproteomics
Proteogenomics

Get Data

S

-
https://galaxyp.msi.umn.edu/tool_runn

Upload and merge (version 1.1.3)

File Format:
raw v
Which format? See help below
Dataset Name:
ATP

Files:

Choose Files | No file chosen
TIP: Due to browser limitations, uploading files larger than 2GB is guaranteed to
fail. To upload large files, use the URL method (below) or FTP (if enabled by the
site administrator).

URL/Text:

s

Here you may specify a list of URLs (one per line) or paste the contents of a file.

Whole directories containing files uploaded via FTP will be merged:
File Size Date

Your FTP upioad directory contains no files.

This Galaxy server allows you to upload files via FTP. To upload some
files, log in to the FTP server at galaxyp.msi.umn.edu using your
Galaxy credentials (email address and password).

Files uploaded via FTP:

File Size Date
# Al_ATP_1.RAW 128.2 MB 05/19/2013 12:28:29 AM
# AL_ATP_2.RAW 123.6 MB 05/19/2013 12:28:57 AM
«# AL_ATP_3.RAW 115.7 MB 05/19/2013 12:29:24 AM

This Galaxy server allows you to upload files via FTP. To upload some
files, log in to the FTP server at galaxyp.msi.umn.edu using your
Galaxy credentials (email address and password).

Convert spaces to tabs:
Yes
Use this option if you are entering intervals by hand.

Genome:

unspecified (7?) v

er’tool_id=multi_upload1

History [+ -

Al_ATP PeptideShaker
0 bytes &/ =

© vour history is empty. Click 'Get
Data' on the left pane to start

[ >

* One can use the “Multiple File Datasets”

button and select multiple file for upload.

* One can use the “Multiple File Datasets” -> “Upload and Merge” tool and paste in multiple URLs to have

Galaxy download these files and create a multiple file dataset.

-> “Upload and Merge” tool and simply click the “Choose Files”
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L9 € | [ localhost

Analyze Data

Tools .

Upload and merge (version 1.1.3)
(_search tools (<) File Format:
GALAXY CORE raw ;
e, Which format? See help below
Send Data Dataset Name:

Multiple File Datasets

= Upload and merge multiple .
files to one dataset. Files:

| Choose Fies | No file chosen

Merge Standard Datasets
{Linked) into Multiple File

by the site administrator).
Dataset

URL/Text:

TIP: Due to browser limitations, uploading files larger than 2GB is guaranteed to fail. To upload large files, use the URL method (below) or FTP (if enabled

Merge Standard Datasets
(Copied) into Multiple File
Dataset.

Solit Multiple File Dataset int
standard datasets (one per

Ftp://ftp.pride.ebi.ac.uk/2013/04/PXD000141/A1_ATP_1.RAW
ftp://ftp.pride.ebi.ac.uk/2013/04/PXD000141/A1_ATP_2.RAW
ftp.pride.ebi.ac.uk/2013/04/PXD000141/AL_ATP_3.RAW

file).

Text Manipulation
Filter and Sort

Whole directories cont:

Join, Subtract and Group
Statistics

Graph/Display Data
Multiple regression
Multivariate Analysis
Motif Tools G
Multiple Alignments
Metagenomic analyses
FASTA manipulation

Your FTP upload directory contains no files.

credentials (email address and password)

Files uploaded via FTP:

090313_01.RAW
090313_02.RAW

090313_03.RAW
PROTEOMICS: GALAXY-P

Peak List Processing credentials (email address and password)

ProteinPilot Convert spaces to tabs:
Statistical Validation = Yes
< Use this option if you are entering intervals by hand.

g files uploaded via FTP wi

Here you may specify 2 list of URLs (one per line) or paste the contents of a file.

File Size

This Galaxy server allows you to upload files via FTP. To upload some files, log in to the FTP server at localhast using your Galaxy

Size
85.7 MB
77.6 MB

85.2 MB

This Galaxy server allows you to upload files via FTP. To upload some files, log in to the FTP ser

be merged:

History z

Unnamed history
0 bytes %

Your history is empty. Click 'Get
Data’ on the left pane to start

K

Date
05/29/2013 01:04:35 PM
05/29/2013 01:04:35 PM
05/29/2013 01:04:35 PM

r at localhost using your Galaxy

4.2. Creating a Multiple File Dataset

59



Using Galaxy-P Documentation, Release 0.1

60

Chapter 4. Multiple File Datasets



CHAPTER 5

A Simple Worklfow using peptide-shaker

This section is a simple walkthrough of using Galaxy-P and multiple file datasets to analysis a collection of RAW files
using peptide-shaker

=7 Galaxy

€ & https://galaxyp.msi.umn.edu

Tools . History on
Upload and merge (version 1.1.3) =~
( search tools 0 Al_ATP PeptideShaker
: > File Format: :
0 bytes FE
GALAXY CORE raw - : : —
Get Data Which format? See help below © vour nistory is empty. Click 'Get

Data’' on the left pane to start

Send Data Dataset Name:
Muitiple File Datasets
= Upload a\ erge multiple
files to anggataset. Flles:
Choose Files | No file chosen
TIP: Due to browser limitations, uploading files larger than 2GB is guaranteed to

fail. To upload large files, use the URL method (below) or FTP (if enabled by the
site administrator).

Merge Standard Datasets
{Linked) into Multiple File
Dataset

Merge Standard Datasets
{Copied) into Multiple File
Dataset

URL/Text:

Split Multiple File Dataset into
standard datasets (one per
file).

Text Manipulation Here you may specify a list of URLs (cne pefline] or paste the contents of a file.
Eilter and Sort

Join, Subtract and Group
Statistics

Graph /Display Data

Multiple regression This Galaxy server allows you to upload files via FTP. To upload some
e S files, log in to the FTP server at galaxyp.msi.umn.edu using your
Muitivariate Analysis Galaxy credentials (email address and password).

Motif Tools
Multiple Alignments

Whole directories containing files uploaded via FTP will be merged:
File Size Date

Your FTP upload directory contains no files.

Files uploaded via FTP:

Metagenomic analyses File Stze Pate

Phenotype Association ¥ Al_ATP_1.RAW 128.2 MB 05/19/2013 12:28:29 AM
EASTA manipulation ¥ A1_ATP_2.RAW 123.6 MB 05/19/2013 12:28:57 AM
PROTEOMICS: GALAXY-P # Al_ATP_3.RAW 115.7 MB 05/19/2013 12:29:24 AM
Peak List Processing This Galaxy server allows you to upload files via FTP. To upload some
ProteinPilot files, log in to the FTP server at galaxyp.msl.umn.edu using your

Galaxy credentials (email address and password).
Statistical Validation

Quantitation Convert spaces to tabs:
MaxQuant Yes

Use this option if you are entering intervals by hand.
Bumbershoot Tools

Metaproteomics Genome:
Proteogenomics unspecified (7) v
Get Data
https://galaxyp.msi.umn.edu/tool_runner?tool_id=multi_upload1 - >
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Galaxy - Mozilla Firefox

File Edit View History Be

=_ Galaxy

€ |a https

usegalaxyp.org/root

okmarks

+ @ |B~ pride raw files q I @

Tools

search tools

GALAXY CORE

Get Data

Multiple File Datasets
Text Manipulation
Filter and Sort

Join, Subtract and Group
Statistics

Graph /Display Data
Multiple regression
Multivariate Analysis
Motif Tools

Multiple Alignments
Metagenomic analyses
Phenof Association
FASTA manipulation

PROTEOMICS: GALAXY-P
Peak List Processing
Statistical Validation
Quantitation

MaxQuant

Bumbershoot Tools
Metaproteomics
Proteogenomics

Get Data

PROTEOMICS: COMMUNITY
Peptide Shaker

mzMatch

Open MS

ProtK

Utilities

Visualization

FASTA Manipulation

Adapt

BIOINFORMATICS
NCBI BLAST+
EMBOSS

Gene Prediction

<

Welcome to Galaxy-P (beta).
Galaxy-P is a variant of Galaxy tailored toward proteomic
data analysis.

History fa I - 5

Galaxy-P is running on disk that is not backed up, you
should not assume data uploaded to or generated with
Galaxy-P will be available in the future. Additionally,
Galaxy-P is in very active development - things will break
and things will change, so your patience is requested.

Tweets W Follow @usegalaxyp

The Galaxy-P Project @usegalaxyp B Mov
Just posted a screencast describing how to export

data from TINT to Galaxy-P.
youtube.com/watch?v=2wxDJj...

The Galaxy-P Project @usegalaxyp 5 Nov
MNews about the Galaxy-P project and servers will be
posted on this twitter account.

Load More

Tweet to @usegalaxyp

Getting Starts with Galaxy-P

A good place to start is the following Galaxy-P 101 page: Building up and
using a proteomics workflow.

The main Galaxy team's screencasts page has many useful screencasts

and tutorials. While some are genomics specific, many will be useful for
proteomics analysis in Galaxy-P.

Useful Links
Uploading databases using links.
Using the protein database downloader tool.

The Galaxy-P source code on Bitbucket
The Galaxy-P issue tracker on Trello

PeptideShaker 101
367.4 MB ]

1: Al (ATP @ %]
Multiﬂlg%ataset raw

format: m:raw, database: ?
Example Multiple File Dataset

HOU =]

This project Is funded by the NSE.
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Galaxy - Mozilla Firefox

File Edit View History Be

+ @ |B~ pride raw files al & &

Tools

search tools

GALAXY CORE

Get Data

Send Data

Multiple File Datasets
Text Manipulation
Filter and Sort

Join, Subtract and Group
Statistics

Graph /Display Data
Multiple regression
Multivariate Analysis
Motif Tools

Multiple Alignments
Metagenomic analyses
Phenof Association
FASTA manipulation

PROTEOMICS: GALAXY-P
Peak List Processing
Statistical Validation
Quantitation

MaxQuant

Bumbershoot Tools
Metaproteomics
Proteogenomics

Get Data

PRIDE BioMart Download
proteomic data from the EBI
Pride BioMart.

Protein Database Downloader

PROTEOMICS: COMMUNITY
Peptide Shaker

mzMatch

Open MS

ProtK

Utilities

Visualization

FASTA Manipulation

Adapt

<

History fa I - 5

Protein Database Downloader (version 0.2.0)
PeptideShaker 101
367.4 MB =

Download from:
UniProtKB =

1: Al ATP ® (R

Multifile dataset raw

format: m:raw, database: ?

Example Multiple File Dataset

reviewed: [=IO]7] ZE
UniProtkKB =

Taxonomy:

Mycobacterium tuberculosis H37Rv (MTB) [Not compl =

Proteome Set:

| Any

Include {"pform data:

Output
A FASTA file containing the specified protein sequences.
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Galaxy - Mozilla Firefox

File Edit View History Be

€ | @ heeps://usegalaxyp.org/root v @ |B~ pride rawfiles Q I
;4

Tools Create Target-Decoy Database (version 0.1.0) HER B
search tools Q) PeptideShaker 101

FASTA Input: ST D=
GALAXY CORE | 2: Protein Database 2 |
Get Data #32: Protein Database @ { 3
Send Data 1: A1 ATP @R
—_— Multifile dataset raw
Text Manipulation format: m:raw, database: ?
Fllter and Sort What it does Example Multiple File Dataset

Given an input database, this tool will produce a target-decoy database in HOG B

Join, Subtract and Group
Statistics
Graph /Display Data
Multiple regression
Multivariate Analysis For the underlying tool, please cite Martens et al. DBToolkit: processing
protein databases for peptide-centric proteomics. Bioinformatics (2005)
_— vol. 21 (17) pp. 3584-5.
Multiple Alignments
If you use this teol in Galaxy, please cite Chilton J, et al.
Metagenomic analyses https://bitbucket.org/galaxyp/galaxyp-tooished-peptideshaker .
Phenof Association
FASTA manipulation

the format required by PeptideShaker using dbtoolkit.

Citation

PROTEOMICS: GALAXY-P
Peak List Processing
Statistical Validation
Quantitation

MaxQuant

Bumbershoot Tools
Metaproteomics
Proteogenomics

Get Data

PROTEOMICS: COMMUNITY

Peptide Shaker

= Peptide Shaker Peform protein
identification combining X!
Tandem and OMSSA (using
SearchGUI) and PeptideShaker
pipeline.

Create Target-DecOy Database
Creates a target-decoy
database for use with Peptide
Shaker

mzMatch

Open MS
ProtK

< >

64 Chapter 5. A Simple Worklfow using peptide-shaker



Using Galaxy-P Documentation, Release 0.1

Galaxy - Mozilla Firefox

File Edit View History

Tools

Get Data

Send Data

Multiple File Datasets
Text Manipulation
Filter and Sort

Join, Subtract and Group
Statistics

Graph /Display Data
Multiple regression
Multivariate Analysis
Motif Tools

Multiple Alignments
Metagenomic analyses
Phenof Association
FASTA manipulation

PROTEOMICS: GALAXY-P

Peak List Processing
= msconvert3 Convert and filter a
mass spec peak list

msconveﬁ raw Convert and
filter a o Finnigan RAW

file

Subset Peak List against list of
scan numbers or indices.

MGF Formatter convert peak
lists into MGF files formatted for
particular downstream
applications.

ms2 preproc preprocess and
filter M5/MS spectra

Search Formatter Use
MzXML2Search to convert peak
lists.

Statistical Validation
Quantitation

MaxQuant

Bumbershoot Tools
Metaproteomics
Proteogenomics

Get Data

PROTEOMICS: COMMUNITY

msconvert3_raw (version 0.2.0)

Thermo Finnigan RAW Input:
1: Al_ATP 3

Output Type:
| mgr &

Use Filtering?:

Advanced Settings:

Use Defaults =

What it does

Converts between various mass spectrometry peak list representations.
Additional options such as filtering and//or precursor recalculation are
available.

You can view the criginal documentation here.

v @ |Ed~ pride rawfiles Q

Citation

For the underlying tool, please cite ProteoWizard: Open Source Software
for Rapid Proteomics Tools Development. Darren Kessner; Matt
Chambers; Robert Burke; David Agus; Parag Mallick. Bicinformatics 2008;
doi: 10.1093/bioinformatics/btn323.

If you use this tool in Galaxy, please cite Chilton J, et al.
https://bitbucket.org/galax: alaxyp-toolshed-msconvert

https://usegalaxyp.org/tool_runner?tool_id=msconvert3_raw

History fa I - 5

PeptideShaker 101

372.7 MB ]

3: Create Target-Decoy @& { ¥

Database on data 2

2: Protein Database @ %

1: Al ATP ® (R

Multifile dataset raw

format: m:raw, database: ?

Example Multiple File Dataset

HOU CB
>
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Galaxy - Mozilla Firefox

File Edit View History Be

okmarks

Bl - pride raw files al & &

Tools

search tools Q)

GALAXY CORE

Get Data

Send Data

Multiple File Datasets
Text Manipulation
Filter and Sort

Join, Subtract and Group
Statistics

Graph /Display Data
Multiple regression
Multivariate Analysis
Motif Tools

Multiple Alignments
Metagenomic analyses
Phenof Association
FASTA manipulation

PROTEOMICS: GALAXY-P
Peak List Processing
Statistical Validation
Quantitation

MaxQuant

Bumbershoot Tools
Metaproteomics
Proteogenomics

Get Data

PROTEOMICS: COMMUNITY

Peptide Shaker

= egﬂ‘:}g Shaker Peform protein
identification combining X!
Tandem and OMSSA (using
SearchGUI) and PeptideShaker
pipeline.

Create Target-Decoy Database
Creates a target-decoy
database for use with Peptide
Shaker

mzMatch

Open MS

ProtK

Utilities

Visualization

EASTA Manipulation

Peptide Shaker (version 0.1.0)

Protein Database:

3: Create Target-Dec..eon data 2 2
Input Peak Lists (mgf):

4: msconvert3_raw on data 1 2

select files directly | by multifile

Precursor Ion Tolerance Units:

Parts per million (ppm}

Percursor Ion Tolerance:

Fragment Tolerance (Daltons):
Enzyme:

Trypsin v
Maximum Missed Cleavages:
Fixed Modification:

» carbamidomethyl ¢
Variable Modification:

» oxidation of m | | x gtp desthiobiotinci2

Minimum Charge:
2

Maximum Charge:

Forward Ion:
B =

Reverse Ion:

Y -

Specify Advanced Search Options:

Specify Advanced Pept Proc Options:

Filtering O H

Specify Advanced P

https://usegalaxyp.org/tool_runner?tool_id=peptide_shaker

History fa I - 5

PeptideShaker 101
664.1 MB ]

4: msconvert3 rawon @ { 3
data 1

3: Create Target-Decoy @& { ¥
Database on data 2

2: Protein Database @ ] B

1: A1 ATP ® R
Multifile dataset raw

format: m:raw, database: ?

Example Multiple File Dataset

HOO A=
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File Edit View

Spectrum File

History Bt

Al_ATP.16058.16058.

Al_ATP.8510.8510.1
Al_ATP.B366.8366.

Al_ATR.17278.17278.

Al_ATP.1993.1993.

Al_ATP.10870.10870.

Al_ATP.6633.6633.
Al_ATP.7348.7348.
Al_ATR.7331.7331.1

Al_ATP.22984.22084.

-

Al_ATP.12992.12992.
Al_ATP.11403.11403.
Al_ATP.10047.10047.
Al_ATP.12494.12494.

Al_ATR.14147.14147.

Al_ATP.B474.8474.
Al_ATP.4615.4615.

[

Al_ATP.11351.11351.

Al_ATP.4388.4388.

Al_ATP.11429.11429.

Al_ATP.4575.4579.

Al_ATP.19966.19966.

Al_ATP.6190.6190.

Al_ATP.13359.13359.
Al_ATR.11163.11163.

Al_ATP.B033.8033.
Al_ATP.5468.5468.1
Al_ATP.8966.8966.

Al_ATR.22172.22172.

[

Al_ATP.15645.15645.
Al_ATP.15020.15020.

Al_ATP.9314.9314.1
Al_ATP.4952.4952.
Al_ATR.7119.7119.
Al_ATP.5902.5902.
Al_ATR.7135.7135.
Al_ATP.9994.9904,

Al_ATP.13544.13544.

Al_ATP.BG0G.8606.

-

Al_ATR.21233.21233.
AL_ATP.12825.12825.

Al_ATP.6806.6806.

Al_ATP.10807.10807.

[

Al_ATP.11264.11264.

Al_ATP.9322.9322.

Al_ATP.14312.14312.

Al _ATR.4477.4477.

> Tnoa17 ea1T

okmarks

Identification File(s)

Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx

A1_ATP_1 (File 1).omx A1_ATP_1 (File 1).t.xml

A1_ATP_1 (File 1).omx
A1_ATP_1 (File 1).omx
A1_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
A1_ATP_1 (File 1).omx
A1_ATP_1 (File 1).omx
A1_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
Al_ATP_1 (File*1).omx
Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
A1_ATP_1 (Flle 1).omx
A1_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
A1_ATP_1 (File 1).t.xml
A1_ATP_1 (Flle 1).omx
A1_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
A1_ATP_1 (File 1).omx
A1_ATP_1 (File 1).omx
A1_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
A1_ATP_1 (File 1).t.xml
Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
A1_ATP_1 (File 1).omx
A1_ATP_1 (File 1).omx
A1_ATP_1 (File 1).t.xml
Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
Al_ATP_1 (File 1).omx
A1_ATP_1 (File 1).omx
A1_ATP_1 (File 1).omx

A1 _ATD 1 ACila 1% amas

Precursor RT
4779.4458
2403.5502
2357.8309
5155.1521

424.4967
3146.9381
1820.4371
2041.1308
2036.1117
6760.8229
3821.3314
3316.1163

2885.758
3663.9835

4186.682
2392.1006
1225.8618
3209.3848
1158.5862
3324.5418
1215.2906
5971.9205

1685.705
3938.0828
3239.4479
2253.6402
1472.6248
2546.2684
6573.0315
4653.0733
4459.4024
2655.4786
1324.9834
1960.2179
1599.1762
1974.2127
2868.7206
3995.9774
2433.4604
6342.1764
3768.0869
1873.5239
3126.8176
3271.3843
2657.9808
4239.0255
1184.9677

274 neja

~@ B~ Google

Precursor mz
964.13
791.40087890625
693.7
950.45
981.53
920.13
741.93
1159.9
719.6
587.56
977.91
993.13
957.52
726.89
518.99
1045.87
404.85
918.19
523.07
1041.6
472.54
639.66
744.05
1043.25
666.84
861.45
800.39
976.17
727.456237792969
776.43
1039.87
824.43
571.06
705.05
737.87
880.49
843.09
324.43
728.79
867.65
797.47
974.55
991.54
1049.54
9031
831.68
343.44

11 a9

:

History fa I - 5

PeptideShaker 101
764.5 MB lZIE]

B: PeptideShaker PSM @& { %
Report for data 3 and data 4

7: PeptideShaker ® R
Protein Report for data 3 and
data 4

6: PeptideShaker @ %
Peptide Report for data 3 and
data 4

5: PeptideShaker CPS @ { &
results for data 3 and data 4
96.9 MB

format: cps, database: ?
makeblastdb command: fopt/galaxy
Jftools/searchguif1.13.1/share
Jjava/SearchGUI-1.13.1/resources
J/mak db/linux/mak db -in
dataset_7.dat Reindexing. Wed May
29 20:33:18 UTC 2013 Formatting
dataset_7.dat for OMSSA. Building
Building a a new new

HOQ GBR

binary data

4: msconvert3 rawon @ { ¥
data 1

3: Create Target-Decoy @& {J &
Database on data 2

8,196 sequences

format: fasta, database: ?

=61 LB

2: Protein Database @R

1: A1 ATP @R

Multifile dataset raw

format: m:raw, database: ? -
>
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Indices and tables

¢ genindex
* modindex

e search
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